
Webster's Encyclopedia of Australia 1998...
Installation
Starting the Program
Startup Options
The Contents
Screen Description and Use
Setting Options
Search
Highlighting Text
Creating a Project
Adding Notes
Bookmarking
Clipboard Support
Go To Page
Page History
Printing
Linking With Other Applications
Toolbar
Slide Show
Word Search



Installation
To install Webster's Encyclopedia of Australia 1998 please follow these instructions:

(i) Turn on your computer and start up the Microsoft Windows operating environment.

(ii) Insert the Webster's Encyclopedia of Australia 1998 into your CD-ROM drive.

(iii) If you are running Windows 95, then the AutoRun program appears, giving you options to run the 
program directly, or install to your hard disk.

(iv) If you are not running Windows 95, or you are and have AutoRun disabled, or if you would simply
like to install the CD manually, choose the 'Run' command from the 'File' menu in the Windows 
Program Manager. (If you are new to using the mouse, simply click on the File name in the menu bar
at the top of the Program Manager screen, and then click on the 'Run' command from the list of 
commands that drops down.)

(v) In the dialog box that then appears, key in the following - x:\setup.exe, where "x" refers to the 
drive letter of your CD-ROM drive (quite often, this is "D").

(vi) Follow the instructions on the screen.

(vii) The installation program will create a program group and icons in your Program Manager.



Starting and Exiting the Program
For users of Windows 95 or higher

This CD is AutoRun enabled, which means that as you insert the CD into your CD player, a program 
is automatically run, allowing you to perform an installation of the program, or run the program.

Alternatively, if you have installed the program, use the Start button to locate the Webster's 
Australian Reference Series group, and the program icons marked 'Encyclopedia of Australia 1998'.

Once the program has started, you can exit the program by clicking on the close button in the top 
right-hand corner.

For users of Windows 3.1, Windows 3.11, Windows for Workgroups.

To start Encyclopedia of Australia 1998, first ensure that you have inserted one of the CDs into your 
CD-ROM drive.

Locate the Program Group called Webster's Australian Reference Series in your Program Manager, 
and double-click on the 'Encyclopedia of Australia 1998' icon.

Once the program has started, you can exit the program using the close button in the top right-hand 
corner of the title bar.



Startup Options
There are several startup parameters that can be used in conjunction with this product to alter 
slightly either its features, or the methods it uses to perform certain features.

A command line parameter is an extra bit of information you add to the startup line of a program. To 
use a command line parameter, you must use the Run command (from either the Program Manager, 
or the File Manager), (or the Start button menu for users of Windows 95), or use the 'Properties' 
command from the Program Manager to permanently affix these parameters.

The available command line parameters are as follows:

/noprint

Using this command line parameter will prevent any printing from taking place from within this 
program.

/nostart

This parameter will start the program, bypassing the very first startup screen.

/noini

This prevents any user settings being saved after the program is closed.



The Contents
The Contents screen allows you to move around your CD-ROM by selecting different chapters and 
sections.

You can select the 'Contents' button from the Toolbar to take you back to the Contents screen.

To see the contents in any chapter, click on that chapter picture. If the chapter has sections, a 
second screen appears where you can choose to enter a section by clicking on the section image.



Screen Description
Let's go over some of the features of a standard page, and how you can use them.

If you read no more, read this - you can navigate through this product using only the buttons in the 
Toolbar. Note that you can move to the 'Next Page', or 'Back One Page'. To view a new section, 
select the 'Contents' button.

Title Bar

The Title Bar appears across the top of the screen and displays the chapter and section name. On 
the right hand side of the Title Bar are the maximize and minimize buttons.

Toolbar

Below the Title Bar is the Toolbar, which contains various buttons. You can perform most normal 
operations on the CD-ROM using these buttons. A brief description of each button can be found in 
the Toolbar section of this help file.

The Text Box

The text box (or window) is where you read the text of the book. You can do various things with this 
text box:

(i) You can change its position on the screen by holding the mouse button down in its title bar and 
moving the mouse around. 

(ii) You can change its size by holding the mouse down on any side of the window, until it changes to 
a horizontal or vertical dual arrow, and then moving the mouse in or out to either reduce or enlarge 
the window.

(iii) You can hide the text box by clicking on the 'Hide Text' button in the Toolbar. If you hide the box in
this fashion, you can display it again by clicking on the 'Show Text' button in the Toolbar. You can also
hide the text box by double-clicking on the text box control menu box (the small box with across in it 
at the right-hand side of the text box title bar).

Status Bar

The Status Bar, below the Toolbar, displays the chapter name and/or page number.



Settings
The 'Settings' dialog box is accessed by clicking on the 'Settings' button from the Toolbar.

This dialog box is used to set quite a number of user preferences. You simply select the options you 
wish to set, and then click on the 'OK' button. All these options will remain when you start this 
program again.

Change Font

When you select this button, you can select a new text font, size, and style for the main text box.

Text Color

When you select a colour from this list, the main text associated with every page will display using 
this colour.

Heading Color

When you select a colour from this list, the heading associated with every page will display using this
colour.

Popup Color

When you select a colour from this list, any popups (i.e. glossary entries) that appear in the text will 
display using this colour.

Jump Color

When you select a colour from this list, any jumps (i.e. hypertext links) that appear in the text will 
display using this colour.

Automatically Play Movie

When you move to a new page, and a movie is associated with this page, this option will determine 
whether that video starts playing automatically, or waits for you to play the video, if you wish.

Automatically Play Sound

 When you move to a new page, and a sound is associated with this page, this option will determine 
whether that sound starts playing automatically, or waits for you to play the sound, if you wish.

No Background Sound

If this option is checked, no background sound will play on the Contents screen.

Alter File Locations

This button provides access to advanced options - options you should never have to use (these 
options are explained below). Normally, these options will remain as they are, but if you change the 



drive letter indentifying your CD-ROM, you may need to adjust these settings.

Pictures Directory

This is the directory the program searches for its picture files.

Sound Directory

This is the directory the program searches for its sound files.

Movie Directory

This is the directory the program searches for its movie files.



Search
The Search dialog box is accessed by clicking on the 'Search' button from the Toolbar.

You use this dialog box to locate a specific item - this may be a word or phrase, user highlights, 
topics, and much, much more.

This dialog box is a rollup - note the two buttons at the top right-hand corner of the dialog 
box. The right-hand button will allow you to alternately roll up, and unroll the dialog box - 
shrinking it, but not removing it from the screen. The button just to the left of this button, with
the cross in it, will hide this dialog box.

The Buttons

Across the top of the dialog box are a series of buttons that allow you to select what you are 
searching for.

Words

Select this button if you would like to search for a specific word, phrase, or part of a word. When you 
click on this button, the Word Search dialog box will appear.

Pages

Selecting this button fills the Page List with the name of every page contained in the title in 
alphabetical order.

Pictures

This button creates a list, in alphabetical order, of all pages that contain a still image.

Movies

This button creates a list, in alphabetical order, of all pages that contain a video.

Graphs

This button creates a list, in alphabetical order, of all pages that contain a graph.

Tables

This button creates a list, in alphabetical order, of all pages that contain a table.

Highlight

This button creates a list, in alphabetical order, of all pages that contain a user added highlight.

Note



This button creates a list, in alphabetical order, of all pages that contain a user added note.

Custom

Select this button to provide a list of custom searches - such as 'Famous Australians'.

Search

This option determines where any search (of the options listed above) takes place. You can search 
the entire multimedia title, the current section or choose one of the other sections to search in.

Article List

Ultimately, the contents of this list are the names of pages that meet the search criteria selected. You
can view any page in this list by double-clicking on the page name, or selecting a page from the list, 
and clicking on the 'Go To Selection' button, below.

Go To Selection

See 'Article List' above.

Stop Search

When you are searching for a word or phrase, this will take a little longer than the other searches. 
For this reason, while a search is being performed for a word or phrase, the 'Hide' button will be 
renamed to the 'Stop Search' button. Clicking on this button will halt the search. Also, if you attempt 
to move to a page while a search is being carried out, the search is halted, and you are moved to the
selected page.

When you go to a selected page that you have for using a word or phrase, the particular word or 
phrase will be highlighted in red and underlined.



Highlighting Text
The 'Highlighter Pen' dialog box appears when you select the 'Highlighter Pen' command from the 
'Edit' menu.

Highlighting text using this dialog box is almost exactly the same as using a highlighter pen in a 
normal book, only more flexible. The easy way to use this technique is to select the text you would 
like to highlight (on the left of this dialog box) in the same way that you select text in a word 
processor. Then select a 'Highlight Color', and select the 'Highlight Text' button. You can then click on
'OK' - the text you highlighted will be highlighted on the screen in the colour you selected, every time 
you come back to this page. To stop this from happening, you can select the 'Remove Highlights' 
button, or deselect the 'Always Display User Highlights' option.

Select Text to Highlight

This section displays the text as it appears on the main screen. Highlight the text as you normally 
would in a word processor. This is the first step in highlighting text.

Highlight Color

In this list box, select the colour that you would like the currently selected text to be highlighted in.

Color Description

This section allows you to define what each colour means to you. You can edit this text, and if you 
wish, make this description different for every colour. This means that you may highlight different text 
in different colours, and this description will remind you why you highlighted text in each particular 
colour. These settings will remain after you shut down this program.

Preview

This section displays the text and highlights as they will appear on the current page.

Highlight Text

This button applies the current highlight to the selected text, in the currently selected 'Highlight 
Color'. 'Preview' will display the result.

Remove Highlights

This button removes all highlights from the current page.

Always Display User Highlights

If this option is checked it ensures that all highlights are applied to the text. When this option is 
deselected, all user added highlights are ignored.



Creating a Project
For more information about creating a project, select the 'Creating a Presentation'/Project' command 
from the Help menu of your CD-ROM.

The 'Projects' dialog box is a rollup - note the two buttons at the top right-hand corner of the 
dialog box. The right-hand button will allow you to alternately roll up, and unroll the dialog 
box - shrinking it, but not removing it from the screen. The button just to the left of this 
button, with the cross in it, will hide this dialog box.

Project Title

This text box is for the name of your project. You may call it anything you wish - you are not restricted
to eight letters.

Your Name

Enter your name into this text box.

Project Summary

In this text box enter a brief summary of your project.

Pages in Project

This is a list of all pages currently in your project.

Page Heading

This text box allows you to enter an alternate name for any page. Select the page from the 'Pages in 
Project' list that you would like to create an alternate name for, and enter a new name into this text 
box.

The 'Up' and 'Down' arrow buttons

These buttons move the currently selected page in the 'Pages in Project' list up or down the list of 
pages. It provides a means to rearrange your project.

Remove Page

This removes the currently selected page from the 'Pages in Project' list from your project.

Add Page

This adds the currently displayed page to your project list.

New

Select this option to clear the current project and start a new one.



Open

Use this option to open an existing project.

Save

Use this button to save changes to the current project.

Save As

This option allows you to create a copy of the current project.

Print

Use this option to print the current project. The project will be printed from the currently selected 
page in the 'Pages in Project' list to the end of the project.

Run

This option runs the current project as an on-screen presentation. The project is run from the 
currently selected page in the 'Pages in Project' list, to the end of the project.

Display User Notes

This option, if selected, ensures that any user notes you have added to any page in your project are 
displayed when you use the 'Run' button to run the presentation.



Adding Notes
If you are using this book for research or educational purposes, you may wish to add notes as you 
move through the different chapters. To do so, you can use the 'Add Note' button from the Toolbar.

When you add notes to a page, the text of that note is saved automatically as you move on. If you 
ever return to this page, you can again view or edit the note you attached to that page by selecting 
the Add Note button once more.

You can print User Notes, as described in Printing.

You can copy User Notes to the Clipboard, as described in the Copy User Note to Clipboard 
command.

You can search for User Notes, as described in the Search Dialog Box.



Bookmarking
Create Bookmark
Goto Bookmark



Create Bookmark
The 'Create Bookmark' dialog box allows you mark a page, using any name you like, so that you can 
return to this page very quickly at any later stage.

This dialog box will appear after selecting the 'Create Bookmark' command from the 'Page Options' 
menu.

Create Bookmark

In this text box, insert the name that you want to identify with the current page.

All bookmarks are saved to the local hard disk, so they will remain when you quit and restart the 
program.

To use the bookmark, select the 'Go To Bookmark' command from the 'Page Options' menu, where 
all bookmarks are listed. To delete a bookmark, you must use options found in the 'Go To Bookmark' 
dialog box.



Goto Bookmark
The 'Goto Bookmark' dialog box allows you to select a bookmark that you have created (using the 
'Create Bookmark' command), so that you can move to this particular page quickly. Both of these 
commands are found in the Page Options menu.

Select Bookmark

In this list are the bookmarks currently defined for this book. If this list is empty, no bookmarks have 
been created. Bookmarks are created using the 'Create Bookmark' command.

Go to Selection

Once you have selected a bookmark from the 'Select Bookmark' list, this button will take you to that 
page. The same effect can be achieved by double-clicking on a bookmark name in the 'Select 
Bookmark' list.

Delete

Once you have selected a bookmark from the 'Select Bookmark' list, clicking on this button will delete
that bookmark (not that page!).



Clipboard Support
Copying Text
Copying Photographs
Copying User Notes



Copying Text
You can copy any text contained within the text window to the Clipboard, and then paste into your 
word processor.

To do this, you choose the 'Copy Text to Clipboard' command from the 'Edit' menu to activate the 
'Copy Text' dialog box. This dialog box initially highlights all text in the text box on the current page. 
You can modify this selection if you want, and then click on the 'Copy' command.

You can also right-click the mouse on the text box to see another short cut menu containing various 
commands, including 'Copy Text to Clipboard'.



Copying Photographs
Whenever a photograph appears on the screen, selecting the 'Copy Picture to Clipboard' command 
from the Edit menu will copy this object to the Clipboard as a DIB (device independent bitmap).

You can also click the right mouse button when the mouse cursor is over the photograph. This 
provides a popup menu, from which you can select the 'Copy Picture to Clipboard'.



Copying User Notes
You can copy any User Note to the Clipboard by selecting the 'Copy User Note to Clipboard' 
command from the 'Edit' menu.

Assuming there is a User Note on the current page, the text of this User Note is then copied to the 
Clipboard. No dialog box will appear as this happens.



Go To Page
This dialog box appears after selecting the 'Go To Page' button from the Toolbar. The 'Go To Page' 
dialog box allows you to select, and move to, any other page in this section. To move to a page in 
another section, you must use the Contents screen.

Required Page #:

In this text box, you can enter the number of the page you wish to move to. This page is selected 
automatically in the list.

Select a Page

In this list are the names and page numbers of every page in the current section. The page you are 
currently on will be highlighted. If you double-click on a page in this list, you will go directly to that 
page.

Go To Selection

Once you have selected a page from the 'Select a Page' list, this button will take you to that page. 
The same effect can be achieved by double-clicking on a page name in the 'Select a Page' list.



Page History
The 'History' dialog box, accessed via the 'Page Options' menu, allows you to select, and move to, 
any page in the book that you have already been to in the current session. Keep in mind, however, 
that the 'Page Options' menu also contains the name of the last ten pages you visited, allowing you 
to return to these pages by selecting them.

This dialog box will appear when you select the 'History' command, from the 'Page Options' menu.

Select a Page

In this list are the names of every page that you have looked at in the current session. If you double-
click on a page in this list, you will go directly to that page.

Go To Selection

Once you have selected a page from the 'Select a Page' list, this button will take you to that page. 
The same effect can be achieved by double-clicking on a page name in the 'Select a Page' list.



Printing
This dialog box appears when you select the 'Print' button, from the Toolbar.

This dialog box controls the printing of pages from this book. You select what you would like to print 
from the 'Pages' section, and then what part of each page you would like to print using the 'Options'. 
Selecting the 'Print' button starts printing. Once you start printing, you can cancel by pressing the 
'Esc' key.

Print Current Page

If you select this option, only the current page will print.

Print Entire Section

If you select this option, all pages in the current section will print. Although the 'From' and 'To' text 
boxes will be inactive, they will display the range of pages that will print.

Print Selected Pages

If you select this option, you can edit the 'From' and 'To' text boxes to set a start and an end page.

Print Book Contents

If you select this option, a list of chapters, and sections within each chapter, will print.

Print Pictures Large

Make sure you select this option if you do not want to print the text on each page - just the pictures. 
Only one picture will appear on each page.

Print Pictures Small

If you select this option, the picture on each page will print as large as possible as will fit on a page 
(after the text on that page has printed). Only one page will appear per printed page.

Print Smaller Pictures

If you select this option, the picture on each page prints at the top right of each page, at a size of 
around 3 inches x 3 inches. Using this option, you can also fit several pages to the printed page 
(assuming they fit).

Do Not Include Pictures

If you select this option, no pictures are printed. Using this option, you can also fit several pages to 
the printed page (assuming they fit).

Print All Pictures on Page

The check box allows you to print all pictures on any one page.



Include User Notes

This check box will force a User Note on each page, if one exists, to print with the other information 
on that page.

Include See Also References

This check box will force Hypertext Links on each page, if they exist, to print along with the other 
information on that page.

Include Date and Time

This check box will force the current system time and date to print with each page number.

Select Printer Font

This button allows you to select the font you would like your printer to use when printing from this 
CD.

Select Printer

This button allows you to select the printer you would like to print to, as well as set printer options.

Print

This button starts the printing process. After printing, you will return to the page you were previously 
on.



Linking With Other Applications
The 'Open Application' dialog box is accessed via the 'Edit' menu. This dialog box is merely a quick 
way of opening your word processor or similar application. Before this dialog box appears, several 
major applications are searched for, and may appear in this list. You can select any program from 
this list to start it from here.

Select Your Application

From this list, you can select any word processor, graphics, or presentation program that appears. 
Double-clicking on any program name will start that program.

Open Selected Program

This button has the same effect as double-clicking on the above list - the selected program will open.



Toolbar
Settings: Selecting this button invokes the 'Settings' dialog box that allows you to change text and 
text background colour, modify the look of the screen, modify picture options, and choose whether to 
automatically play sound or movies as you move to a page.

Search: Selecting the 'Search' button invokes the 'Search' dialog box that allows you to search for a 
wide range of options including words, topics, user-added notes, highlighted text, video, graphs, 
tables and/or sound.

Print: Clicking on this button displays the Print dialog box. Printing capabilities are very extensive and
are discussed in the Printing section.

Add Note: The 'Add Note' button allows you to add your own text to any page in this CD-ROM. Click 
on this button to display a pop-up window and simply key in your text.

Create Project: This button provides access to the 'Projects' dialog box.

Back One Page: Clicking on this button takes you back one page. (Please note that the page number
is always shown at the top of the text box window as well as in the Status Bar below the Toolbar.)

Next Page: Clicking on this button moves you forward one page at a time.

Contents: Clicking on this button takes you back to the Contents screen.

Go To Page: This option provides access to the 'Go To Page' dialog box, to move around the current 
section.

Hide/Show Text: Clicking on this button hides the text currently displayed in a text window on the 
screen. Once you have done this, this button changes to Show Text, which then allows you to re-
display the text on the screen.

Edit Menu: Clicking on this button activates the Edit menu.

Page Options Menu: Clicking on this button causes the 'Page Options' menu to appear.

Interaction Menu: Clicking on this button causes the 'Interaction' menu to appear.

Help Menu: Clicking on this button causes the 'Help' menu to appear.



Slide Shows
At any stage, you can select the 'Run in Documentary Mode' command, from the 'Interaction' menu 
to run the product as a slide show. In other words, there is no need to turn the pages manually.

The slide show will play from the current page to the end of the current section. The way it works is 
quite simple. If there is a sound, movie, or animation on a page, that sound, movie or animation is 
played until it finishes, and the program moves to the next page automatically. If there is no sound, 
movie, or animation associated with a page, then that page is displayed for 10 seconds before 
moving on.

You can cancel a slide show by pressing the 'Esc' key.



Word Search
The Word Search dialog box appears when you select the 'Word' button, from the Search Dialog 
Box. This dialog box is used to search for a word or phrase. Quite simply, enter the word or phrase 
into the 'Text to Search For' text box; choose the search area, and then click on 'OK'. This dialog box 
will then disappear, and you will return to the 'Search Dialog Box', where all pages that contain the 
text you searched for will be listed.

Text to Search For

In this text box, enter the text you would like to search for. If you would like to search for more than 
one word or phrase, use the text boxes to the right of this first text box. You can also select 'or' or 
'and' from the drop-down list that separates these text boxes.

Search Pages

If you check this option, the main text from every page will be searched for the particular word or 
phrase.

Search Page Names

If you check this option, the title of every page in this book will be searched for the particular word or 
phrase.

Search Tables

Select this option to include all tabular information in the search.

Search Graphs

Select this option to include all graphical information in the search.



Startup Screen
In the Introductory screen, you can choose any of the following options by clicking on them once with
your mouse:

Webster Publishing

Select this option to view a video, introducing you to Webster Publishing.

Tutorial

Select this option to start the tutorial - a guide on how this CD works, and what you might expect to 
find.

Get Started:

Select this option to move directly to the Contents screen.

Introductory Video:

Select this option to view a video introducing you to 'Webster's Encyclopedia of Australia 1996'.



Add Note
<Adding Notes>



Animal Search
<Mammal Search>



Australia - The Multimedia Experience
The title of this multimedia, interactive CD-ROM.



Back One Hyperpage Command
<Back One Hyperpage>



Back One Page Command
<Toolbar>



Beginning Command
<Toolbar>



Clipboard Support
<Clipboard Support>



Contents Command
<The Contents>



Contents dialog box
<The Contents>



Contents Rollup Command
<Contents Rollup>



Contents Rollup
<Contents Rollup>



Copy Picture to Clipboard Command
<Copying Photographs and Tables>



Copy Text to Clipboard Command
<Copying Text>



Copy User Added Text to Clipboard
<Coping User Added Text>



Copy User Note to Clipboard Command
<Copying User Notes>



Create Bookmark Command
<Create Bookmark>



Create Bookmark
<Insert Bookmark>



Create/Load Library Command
<Creating and Loading Libraries>



End Command
<Toolbar>



Full Screen Command
<Toolbar>



Go To Bookmark Command
<Go To Bookmark>



Go To Bookmark Dialog Box
<Go To Bookmark>



Go To Page Command
<Go To Page>



Hide Text Command
<Toolbar>



Highlight
<Highlighting Text>



Highlighter Pen Command
<Highlighting Text>



History Command
<Page History>



Hypertext Links
<Related Topics>



Image Manipulation Command
<Image Manipulation>



Insert Bookmark
<Insert Bookmark>



Next Page Command
<Toolbar>



Open Application Command
<Linking With Other Applications>



Options Command
<Setting Options>



Options
<Setting Options>



Play Sound/Video Command
<Working With Video and Sound>



Play Video
<Working With Video and Sound>



Print Command
<Printing>



Print dialog box
<Printing>



Printing
<Printing>



Quit Command
<Starting and Exiting the Program>



Restore Picture Command
<Image Manipulation>



Run as Slide Show Command
<Slide Shows>



Search Command
<Search>



Search Dialog Box
<Search>



Search
<Search>



Show Text Command
<Toolbar>



slide show
<Slide Shows>



Startup Screen Command
<Using the Program>



Startup Screen
<Using the Program>



Status Bar
<Screen Description>



Toolbar
<Toolbar>



Tutorial Command
<Using the Program>



User Note
<Adding Notes>



Word Search
<Word Search>



Zoom In Command
<Image Manipulation>






